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Creation Suites 2011  

 
 

リリースノート 

本リリースノートでは、Autodesk 3ds Max Entertainment Creation Suite 
2011 の最新の更新内容についてお知らせいたします。 目次 

新機能 
サポート対象のオペレーティン

グシステム 
ハードウェア最低要件 
Autodesk Entertainment 
Creation Suiteのインストール 
アンインストールの手順 
3ds Max リリースノート 

MotionBuilder リリースノート 

Mudbox リリースノート 



Autodesk 3ds Max ECS 2011 

  リリースノート – 2010 年 4 月 7 日 

 

ページ | 2 

新機能 
ここでは、Autodesk® Entertainment Creation Suite 2011 の新機能および機能強化につ 
いて説明します。 本スイートの各製品（3ds Max、MotionBuilder、Mudbox）のリリース

ノート情報が用意されています。   
 
Autodesk のインストールおよびライセンス 
 

 本リリースでは、他の Autodesk ソフトウェア製品と同様、Autodesk のインス 
トールおよびライセンスに関する標準スキームがサポートされ、ユーザーの 
皆様にとって分かりやすくなっています。  

 

Autodesk FBX のサポート 

 Autodesk® Entertainment Creation Suite 2011 でリリースされるすべての製品に、 
同じバージョンの FBX が統合されています。 

 

設定可能なキーボードおよびナビゲーションメカニズム 

 Mudbox 2011 および MotionBuilder 2011 では、キーボードのレイアウトとナビゲーション 
メカニズムをカスタマイズすることができます。 

IPv6 のサポート 

 本リリースでは、Internet Protocol Version 6（IPv4 の後継）がサポートされています。 
IPv4 では 32 ビットのアドレスしかサポートされませんが、IPv6 では 128 ビットの 
アドレスを使用できます。 

 

Windows 7 のサポート 

 本リリースは、Microsoft Windows 7 Professional（64 ビット）オペレーティング システム

にインストールできます。  

サポート対象のオペレーティングシステム 
32 ビット版の Autodesk® Entertainment Creation Suite 2011 ソフトウェアは、以下の 
オペレーティング システムでサポートされています。  

 Microsoft® Windows® XP Professional Service Pack 3 

64 ビット版の Autodesk® Entertainment Creation Suite 2011 ソフトウェアは、以下の 
オペレーティング システムでサポートされています。  
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 Microsoft® Windows® 7 Professional  
 Microsoft Windows Vista Business Service Pack 1 
 Microsoft Windows XP x64 Edition Service Pack 2 

ハードウェア最低要件 
Autodesk® Entertainment Creation Suite 2011 ソフトウェアには、以下のハードウェア

最低要件を満たすシステムが必要です。  

 プロセッサ最低要件 
o Intel® Core™ 2 Quad 64 ビットプロセッサ  
o Dual-Core Intel® Xeon® 64 ビットプロセッサ  
o Dual-Core AMD Opteron™ 64 ビットプロセッサ  

 推奨プロセッサ 
o Intel® Core™ i7 64 ビットプロセッサ  
o Dual Quad-Core Intel® Xeon® 64 ビットプロセッサ  
o Quad-Core AMD Opteron™ 64 ビットプロセッサ  

 最小 2 GB の RAM、4 GB の RAM を推奨（32 ビット版） 
 最小 4 GB の RAM、8 GB の RAM を推奨（64 ビット版） 
 6 GB のハード ドライブ空き容量（同一のシステム上にコマーシャル アプリケーション 

すべてをインストールする場合）   
o Entertainment Creation の Education Suite には、最小 10 GB の空きディスク容量が

必要 
 512 MB のハードウェア アクセラレータ処理による OpenGL® 2.0（以上）の高性能グラ 

フィック カード。Autodesk の認定ハードウェア ページに記載されている推奨ドライバを 
使用。 スリーボタン マウス（マウス ドライバ ソフトウェア付属）。 

o DirectX 9.0c アプリケーション プログラミング インターフェイス以上 
 スリーボタン マウス（マウス ドライバ ソフトウェア付属）または認定 Wacom®タブレット 
 DVD-ROM ドライブ 
 Ethernet アダプタまたはワイヤレス インターネット カード  
 1280 x 1024 の画面解像度 

Autodesk Entertainment Creation Suite のインストール 
DVDを読み込むか、Autodesk® Entertainment Creation Suite 2011の実行ファイルをダウン

ロードしたフォルダに移動し、ファイルをダブルクリックします。 
 
注意：Suite 2011 のインストール中に、ソフトウェアのシリアル番号とプロダクトキーの入力を 
求められます。 本製品のシリアル番号とプロダクトキーをお手元にご用意ください。  
 
重要：ソフトウェアのアクティベーションを行うには、シリアル番号が必要です。 
画面に表示される指示に従い、製品のインストールとアクティベーションを行ってください。 
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Autodesk Backburner 2011 ユーザーへの注意事項：Maya Entertainment Creation  
Suite 2011 に Autodesk Backburner 2011 が付属しています。 Backburner 2011 は、以前の 
バージョンの Backburner がインストールされているコンピュータでは実行できません。  
また、2011 より前の 3ds Max リリースで使用することもできません。 

アンインストールの手順 
Windows XP 

1. ［スタート］>［設定］>［コントロールパネル］を選択し、［プログラムの追加と

削除］ダイアログを開きます。  
2. 削除するプログラムを選択します。 
3. ［削除］ボタンをクリックします。  
4. ［はい］をクリックしてアンインストールを続行します。  

Windows VistaおよびWindows 7 

1. ［スタート］>［コントロールパネル］>［プログラム］>［プログラムと機能］を

開きます。  
2. 削除するプログラムを選択します。  
3. ［削除］をクリックします。 
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Autodesk® 3ds Max 2011 
 

 

リリースノート 

この readme には、Autodesk® 3ds Max® 2011 および Autodesk® 3ds Max® Design 2011 ソフ

トウェアのインストールと使用方法に関する最新の情報が記載されています。ソフトウェア

をインストールする前に、このドキュメントをすべてお読みになることを強くお勧めします。

また、リファレンスとして、この readme をハード ドライブに保存してください。インス 
トールおよびネットワークに関する詳細は、『Autodesk 3ds Max 2011 / 3ds Max Design 
2011 インストール ガイド』をお読みください(通常のインストールおよびネットワーク配置

に関する説明が含まれています)。このガイドは、インストーラの[ドキュメントを読む]リン

クからアクセスできます。  

新機能に関する情報は、3ds Max / 3ds Max Design のヘルプの「新機能」のセクションをお

読みください。  

学習リソース: 
autodesk.co.jp/3dsmax-learningpath または autodesk.co.jp/3dsmaxdesign-learningpath  
をご覧ください。 

サポート情報: 
http://www.autodesk.co.jp/me-support をご覧ください。  

3ds Max Composite の readme (リリース ノート): 
www.autodesk.com/3dsmax-releasenotes をお読みださい。 

その他のスイート製品のドキュメント

は、http://www.autodesk.co.jp/entertainmentcreationsuites-documentation をご覧ください。 

SDK に関する最新情報は、『SDK Programmer's Guide』の「What's New: 3ds Max 2011」
を参照してください。このガイドは、<maxsdk_install_root>\help\3dsMaxSDKFull.chm にあ

ります。
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日本語版に関する注意点 

FBX 書き出し 

• ファイルの書き出しダイアログでいくつかの日本語文字が正しく表示されない場合がありますが、書

き出されたファイルには問題ありません。  

Point Cache モディファイヤ 

• Point Cache モディファイヤを適用し、アニメーション ファイルを XML 形式で保存する場合、オブ 
ジェクト名がファイルの既定値として使用されます。オブジェクト名に日本語をご使用の場合、 
ファイル名が正しく表示されません。その場合は、再入力してください。  

OBJ ファイルの書き出し 

• OBJ ファイル 形式でシーンの書き出しを行った場合、ファイル名とそのパス名に日本語を使用するこ

とができません。これは OBJ ファイル形式の制限です。  

MAXScript リファレンス 

• この DVD に含まれている MAXScript リファレンスは英語版です。日本語版の MAXScript リファレン

スは後ほど Web にて提供される予定です。  

ネットワーク レンダリング 

• レンダリングの出力ファイル名またはパス名に使用できない日本語文字があります。エラーが発生し

た場合、ファイル名またはパス名をすべて英語にして出力を行ってください。また、256 バイト以上

(パスを含む)のファイル名はサポートされていません。  

レンダリング出力 

• 3ds Max 2011 / 3ds Max Design 2011 64 ビット版でレンダリング出力を AVI ファイル形式で行う場合、 
MJPEG Compressor または未圧縮を選択してください。  

地域の設定 

• 日本語版 3ds Max 2011 / 3ds Max Design 2011 をご使用になるには、日本語版のオペレーション  
システムが必要です。 また、お使いのオペレーション システムの言語設定(設定→コントロール 
パネル→地域のオプション→ロケール)を日本語以外に設定すると MAXScript 関係のエラーが 
発生します。言語設定は必ず日本語をお使いください。  

Backburner 2008 インストール ガイド内、「カスタマ サポートへのご連絡」情報の更新 

• 技術サポートは認定販売パートナーが承ります。認定販売パートナーの確認は、下記ウェブサイトに

て御願いします。  
http://www.autodesk.co.jp/reseller 
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前提条件 
Autodesk 3ds Max 2011 / Autodesk 3ds Max Design 2011 のインストールおよびアンインストールの手順は、

『Autodesk 3ds Max 2011 / 3ds Max Design 2011 インストール ガイド』に記載されています。このガイドは、

インストーラの[ドキュメントを読む]リンクからアクセスできます。  

Autodesk 3ds Max 2011 / Autodesk 3ds Max Design 2011 のインストールおよびライセンスに関する留意点を

いくつか、以下に記載します。  

• 権限の限られたユーザが、Windows オペレーティング システム上で Autodesk 3ds Max 2011 / 
Autodesk 3ds Max Design 2011 を使用するためには、完全な権限を持つ管理者がインストールを実行

し、少なくとも 1 度は起動する必要があります。この操作によって、インストールに必要なレジスト

リ情報が生成されます。  
• Autodesk 3ds Max 2011 / Autodesk 3ds Max Design 2011 用のサードパーティ製プラグインをインス

トールするには、完全な権限を持つ管理者が、少なくとも 1 度は 3ds Max 2011 / 3ds Max Design 
2011 を起動する必要があります。この操作によって、サードパーティ製プラグインに必要なフォルダ

が生成されます。  
• (Windows 7 オペレーティング システム) 3ds Max 2011 または 3ds Max Design 2011 を 3ds Max 

2010 または 3ds Max Design 2010 と同時にインストールするには、3ds Max 2010 ホットフィックス 
7 (2009.09.22) をインストールする必要があります。このホット フィックス

は、http://usa.autodesk.com/adsk/servlet/item?siteID=1169823&id=14045685 でダウンロードでき 
ます。  

ベータ版使用時の製品版インストール 
Autodesk 3ds Max 2011 / Autodesk 3ds Max Design 2011 のベータ版(リリース候補(RC)版を含む)がインス 
トールされている場合、製品版をインストールする前に、ベータ版をアンインストールし、プレリリース版に

関連するシステム フォルダをすべて削除する必要があります。ベータ版ソフトウェアのアンインストール手順

については、ベータ ポータルの Beta 版用または RC 版用の readme ファイルをお読みください。 

品質向上プログラム(CIP: Customer Involvement Program)  
3ds Max / 3ds Max Design をはじめて起動すると、[オートデスク品質向上プログラム]ダイアログ ボックスが

開きます。[オートデスク品質向上プログラム]への参加を選択すると、3ds Max / 3ds Max Design は、システ

ム構成、最も多く使用する機能、遭遇した問題、製品の今後の方向性に役立つその他の情報を自動的にオート

デスクに送信します。詳細は、www.autodesk.com/cip を参照してください。 

CIP を有効にするには 

1. 3ds Max / 3ds Max Design を起動します。  
2. [オートデスク品質向上プログラム]ダイアログ ボックスが自動的に表示されない場合には、[ヘルプ]

メニューで[品質向上プログラム]をクリックします。  
3. [オートデスク品質向上プログラム]ダイアログ ボックスで、[はい、参照します]を選択し、任意で連

絡先の情報を入力します。  
4. メール アドレスは正確に入力してください。［OK］をクリックします。  

  

http://usa.autodesk.com/adsk/servlet/index?siteID=1169823&id=13214471�
http://www.autodesk.com/cip�
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カスタマー エラー レポート（CER） 
エンド ユーザの皆様からご送信いただく CER によって、オートデスクは Autodesk 3ds Max および Autodesk 
3ds Max Design の安定性を大幅に向上させることができます。CER への入力に貴重な時間を割いていただい

たことに、感謝いたします。また、エラー発生時にどのようなアクションを実行中であったか、できる限り詳

しい情報を入力していただくようお願い申し上げます。いただいた詳細な情報によって、3ds Max および 3ds 
Max Design Quality Engineering チームはプログラムの向上を円滑に進めることができます。  

CER の詳細については、www.autodesk.com/cer(英語)をご覧ください。  

機能の制限と注意事項 
以下に、Autodesk 3ds Max 2011 / Autodesk 3ds Max Design 2011 での既知の機能上の制限と注意事項をリス

トします  

機能 制限と注意事項 
3ds Max 
Composite  

• 3ds Max Composite に関する問題は、別のリリース ノートに記載されていま

す。www.autodesk.com/3dsmax-releasenotesを参照してください。  
• また、インストール時の問題 の 3ds Max Composite に関する記述も参照し

てください。  

Autodesk® 
Backburner™ 

• Autodesk Backburner 2008.1 は、3ds Max 2011 / 3ds Max Design 
2011 でインストールされる既定値のバージョンの Backburner です。DVD
にはこの他に 2011 および 2008.2(iPv6)の 2 つのバージョンの Backburner が収

録されています。3ds Max / 3ds Max Design 2011 で使用できる Autodesk 
Backburner のさまざまなバージョンについては、『Autodesk 3ds Max 
2011 / Autodesk 3ds Max Design 2011 インストール ガイド』を参照して

ください。インストーラで、[ドキュメントを読む]をクリックしてください。  
• 重要: Autodesk Backburner 2011 は、2011 より前の 3ds Max / 3ds Max 

Design のどのバージョンとも互換性がありません。  

Autodesk® FBX® • 相互運用性を最大にし、Autodesk FBX ワークフローを最も円滑にするために

は、Autodesk 3ds Max 2011 / Autodesk 3ds Max Design 2011 を 
Autodesk® Revit® 2011 とともに使用することをお勧めします。  

• Autodesk Revit 2011 FBX ファイルを読み込み、マテリアル、環境、RPC、
ライトを保持するためには、3ds Max 2011 / 3ds Max Design 2011 が必要

です。  
• 3ds Max 2010/2009 または 3ds Max Design 2010/2009 で Revit FBX 

2011 ファイルを読み込むことは可能です。ただし、読み込まれるのはジオメ

トリとカメラだけです(マテリアル、ライト、環境は失われます)。  
• Revit 2010/2009 FBX ファイルは、3ds Max 2011/2010/2009 または 

3ds Max Design 2011/2010/2009 に問題なく読み込むことができます。  
• FBX のファイルリンク: 3ds Max 2011 / 3ds Max Design 2011 に 

Autodesk Revit 2011 FBX ファイルを読み込む際に、3ds Max / 3ds Max 
Design のシステム単位がフィート以外に設定されていると、スケールの問題

が発生します。Revit FBX ファイルを 3ds Max / 3ds Max Design に読み込

む場合、システム単位がインチに設定されていると、フォトメトリック ライト

のエミッタ シェイプが正しくスケールされません。長さと幅が、本来の 12 分
の 1 になります。回避策: FBX の読み込みまたは File Link 機能を使用する前

に、3ds Max / 3ds Max Design が使用するシステム単位をフィートに設定

します。  
 
 
 
 
 

http://www.autodesk.com/cer�
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• Autodesk マテリアル ライブラリ: FBX AutoCAD の埋め込みテクスチャま

たはリファレンス テクスチャは読み込まれません。書き出すときには、[単一

のロケーションにテクスチャをコピー]を選択する必要があります。テクスチャ 
アセットは、GUID のラベルが付けられ、AutoCAD で指定された場所ではな

く一時フォルダに置かれます。 

Autodesk 
Inventor® の 
読み込み 

• ボディ オブジェクトとして追加する場合には、徐変フィレットはサポートされ

ません。  
• ばねは、ボディ オブジェクトとして正しく読み込まれません。  
• 古いバージョンの Autodesk Inventor に読み込んだ IGES ファイルから作成

したファイルは、ボディ オブジェクトとして読み込まれません。  
• ボディ オブジェクトとして読み込んだ場合、Inventor アセンブリ内の溶接オ

ブジェクトのマテリアルはサポートされません。  
• ボディの上書きを含むアセンブリをボディ オブジェクトとして読み込んだ場

合、対応するボディのマテリアルはサポートされません。  
• WIRE ファイルは、透明マテリアル付きで読み込まれます。必要であれば、マ

テリアル エディタで透明度を完全に透明にすることができます。または、アセ

ンブリ ファイルを[Inventor マテリアルの読み込み]をオフに設定して読み込

むこともできます。  
• ボディ オブジェクトとして読み込まれた WIRE ファイルは、Autodesk Alias 

Studio で使用する IGES ファイルとして書き出すために NURBS に変換する

ことはできません。  
• WIRE の読み込みでは、サーフェスの名前は読み込まれません。  
• 古い Inventor ファイルの読み込みでは、不正なエラー メッセージが表示され

る可能性があります。  
• オブジェクトの読み込みはできても、ジオメトリが見つからなかったり、間 

違った場所に置かれている場合があります。このような現象が起きたら、SAT 
として書き出してから読み込んでみてください。また、バージョンによって 

サーフェスの表現方法が異なるため SAT のバージョンを変更することで異な

る結果が得られる場合もあります。  

Autodesk® 
Material Library  

• Autodesk マテリアルの高度なパラメータ(アンビエント オクルージョン、 

ラウンド コーナー、パフォーマンス調整)は、現時点ではサポートされていま

せん。  
• ライブラリのアンインストールは逆の順序で行う必要があります  

1. 最初に Autodesk Material Library 2011 Medium Image Library 
をアンインストールします。  

2. 次に Autodesk Material Library 2011 Base Image Library を 

アンインストールします。  
• メタル カットアウト プリセットを使用した AutoCAD ファイルは、正しく読

み込まれません。  
• 水反射プールマテリアルは、ロード時には別のカラーでレンダリングされま

す。ロード後に調整する必要があります。  
• Autodesk Material を使用しているシーン ファイルは、他の 3ds Max / 3ds 

Max Design マテリアルを使用している場合より、ロードが遅くなることがあ

ります。  
• 多数の Autodesk Material を MAXScript でインスタンス化すると、プログラ

ム エラーが生じることがあります。  
• Autodesk Material ビットマップは、3ds Max または 3ds Max Design の 

ビットマップ プロキシ機能をサポートしていません。  

警告: Autodesk マテリアル ライブラリをアンインストールすると、AutoCAD、

Autodesk Revit、Autodesk Inventor などのオートデスク製品に悪影響を及ぼす

ことがあります。  
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Autodesk® 
Network License 
Manager  

• ライセンスの問題 を参照してください。  

キャディ • 米国標準の単位を使用した場合、スピナのテキストが途中までしか表示されま

せん。  

CAT • CAT リグの["(利用可能)"]項目がハイライト表示された状態で、[モーション]
パネル > [レイヤー マネージャ]ロールアウトのカラー見本をクリックし、次

に[カラー セレクタ]ダイアログをクリックするとクラッシュが発生します。回

避策: これを回避するには、ハイライト表示されたアニメーション レイヤのみ

を対象にカラーを変更します。  

コンパクト マテリ

アル エディタ  
• コンパクト マテリアル エディタでは、[マテリアルをシーンに追加]ボタンが

機能しなくなりました。  

コンテナ • [削除]を使用した場合、選択されている継承されたコンテンツはコンテナから

削除されません。この機能では、ローカルで追加されたオブジェクトだけをコ

ンテナから削除できます。  
• ソースに新しいプロキシを追加しても、継承されたコンテナ プロキシのリスト

は更新されません。  
• 他の継承されたコンテナ内にネストされたコンテナは、定義が最初にローカル 

パスを使用して指定されている場合、内容のロードに失敗します。これを解決

するには、アセット トラッキングで、コンテナ定義のパスをネットワーク ド
ライブ上に設定し直すか、現在のパスを[ユーザパス]ダイアログ ボックスの

[外部ファイル]パネルに追加します。  
• 継承された内容の階層について行ったローカルでの変更は、更新時に失われま

す。元の階層が復元されます。  
• 複雑なリグまたは階層をコンテナに追加する場合、コンテナの位置を(0,0,0)に

するか、すべての内容が(0,0,0)にある共通の親を持つようにすることをお勧め

します。  
• CAT および Biped リグは、コンテナ内では正しく動作しません。たとえば、

コンテナが移動されてもこれらは移動しません。また、継承時に更新されま 

せん。  
• 継承されたコンテンツのマテリアルを編集する場合には、新しい名前を付ける

必要があります。ローカル マテリアルの名前がソース マテリアルの名前と同

じだと、ロックされている場合でも継承されたコンテンツのマテリアルは更新

されます。  
• コンテナが保存され開いている場合、コンテナおよびその内容に対して同時に

[Shift]+移動を使用すると、不要な複製が作成されることがあります。  
• [ソース定義を合成]または[すべてのコンテナを個別化]では、ソース ルールが

[新しいオブジェクトの追加のみ]または[すべてのロック解除されたオブジェク

ト]に設定されている継承されたコンテナ内の内容の複製が作成されます。 

回避策: [ソース定義を合成]または[すべてのコンテナを個別化]を使用する前

にコンテナをロード解除します。  

グラファイト モデ

リング ツール  
• [オブジェクト ペイント]を使用してビュー平面に垂直なサーフェスまたは 

グリッドにペイントすると、オブジェクトの数と配置が予想しない結果になる

可能性があります。  
• [PolyDraw] > [トポロジ]ツールは、[ユーザ]および[パースペクティブ] 

ビューポートのみをサポートします。  

Ink 'n Paint  
マテリアル  

• mental ray® での Ink 'n Paint マテリアルのインク線の配置が、3ds Max / 
3ds Max Design の以前のバージョンとは異なります。  
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インストール時の

問題  
• (Windows XP オペレーティング システムのみ) サイレントで配置をインス

トールすると、インストールの終了時に通知することなくシステムが再起動さ

れます。これは、一般に PC に MSI 4.5 がないことが原因です。  
• ライセンスを切り替える –yc コマンドは、3ds Max / 3ds Max Design での

み機能します。3ds Max Composite、Autodesk® MatchMover™ などのその

他のソフトウェアでは機能しません。  
• 3ds Max Composite / MatchMover を正しく機能させるには 3ds Max / 

3ds Max Design がインストールされている必要があります。  
• 3ds Max Composite などのパートナーおよびプラグインを実行する前に、

3ds Max / 3ds Max Design を 1 回は実行する必要があります。3ds Max 
Composite では、これによりネットワーク ライセンスを使用していることが

確認され、正しく動作するようになります。  
• (Windows 7 オペレーティング システムのみ) 3ds Max 2011 または 3ds 

Max Design 2011 を 3ds Max 2010 または 3ds Max Design 2010 と同時

にインストールするには、3ds Max 2010 ホットフィックス 7 (2009.09.22) 
をインストールする必要があります。このホット フィックス

は、http://usa.autodesk.com/adsk/servlet/item?siteID=1169823&id=14045685 
でダウンロードできます。  

ライセンスの問題  • (Windows Vista および Mac® Boot Camp® オペレーティング システム

のみ) クライアントとサーバが同じマシン(IPv4)上にある場合、ネットワーク 
クライアントは有効なライセンスを取得することができません。回避策: この

問題を回避するには、次の手順を実行します。  
1. マシンの IP アドレスを取得します。(ipconfig コマンドまたは 

LMTOOLS の[System setting]で取得できます)。  
2. C:\Windows\System32\drivers\etc フォルダにある、hosts ファ

イルを開きます。  
3. hosts ファイルに IP アドレスとホスト名を追加します。たとえば、

10.148.220.50 ACRDLICENSEQA1 のような形式です。  
4. hosts ファイルを保存します。  

これで有効なライセンスを取得できるようになります。  

• 2011 製品をインストールした後で、2010 製品を並列インストールすると、

Registration-Activation Error (0015.111) が表示されます。これは、オフ

ライン(手動)アクティベーションでのみ起こります。  
• (iPv6 ネットワークのみ) Autodesk Network License Manager: iPv6 

ネットワークでライセンス サーバを使用している場合、Autodesk Network 
License Manager にパッチをインストールする必要があります。インストー

ルしない場合、ライセンス サーバは機能しません。  

パッチをインストールするには 

1. ライセンス サーバをシャット ダウンします。  
2. ..\Program Files\Autodesk Network License Manager ファイル

の内容をバック アップします。既定値では、これらのファイルは

(C:\Program Files\Autodesk Network License Manager)にあり

ます。  
3. http://www.autodesk.com/nlm2011-ipv6-windows で、パッチをダウン

ロードします。  
4. パッチを解凍し、新しいファイルを ..\Program Files\Autodesk 

Network License Manager の古いファイルに上書きで貼り付けます

(4 ファイルが上書きされます)。  
 
 
 

http://usa.autodesk.com/adsk/servlet/index?siteID=1169823&id=13214471�
http://www.autodesk.com/nlm2011-ipv6-windows�


 

ページ | 8 

5. ライセンス サーバを再起動します。 
ライセンス サーバは期待通りの動作をするようになるはずです。  

ローカライズ • [ビットマップ パラメータ]ロールアウトで、マルチバイトのファイル名が正し

く表示されないことがあります。  
• キャディの右クリック コンテキスト メニューはローカライズされていま 

せん。  

MAXScript  • range_check および MXS_range_check が、整数値にエラー メッセージを

返し、壊れたエラー メッセージが表示されることがあります。  

mental mill®  • mental mill は、3ds Max 2011 / 3ds Max Design 2011 に同梱されま 

せん。Web ページ(www.autodesk.com/3dsmax-mentalmill)よりダウンロード

してください。  

mental ray®  • mental ray が、レンダリングの終了時にメモリを解放しないことがありま

す。回避策: 3ds Max / 3ds Max Design を再起動してください。  
• 特定のケースで、mental ray レンダラーを使用しているときに DirectX マテ

リアルに XMSL をロードすると、ソフトウェアが機能しなくなる可能性があり

ます。回避策: 3ds Max / 3ds Max Design でスキャンライン レンダラーま

たは Quicksilver レンダラーを使用します。  

MetaSL • Autodesk メタル マテリアル: カスタムのリリーフ マップが機能しません。  
• mental ray を使用する場合、Illumination Phong MetaSL ノードには、

Normal 入力にワイヤリングされた Normals make Normal ノードが必要 

です。  
• MetaSL ノードを操作する場合には、スレートの使用を推奨します。  
• [ハードウェア マップをビューポートに表示]が有効化されておらず、チェック

されていない場合は、不透明マップの使用時にジオメトリが表示されません。 

パーティクル • Shape Facing オペレータを使用して、パーティクルをデイライト システムに

向けている場合、太陽の位置または方向を調整すると、パーティクルが一時的

にビューポートに表示されなくなります。  

Quicksilver  • シーン内でシャドウ付きのライトを多数使用すると、ビデオ メモリ リソース

がすぐに消費されます。これによりレンダリングが低速になったり、ビデオ  
カードがリセットされる場合があります。  

• アンチエイリアシングの設定を高くすると、レンダリング結果が黒になる場合

があります。  
• Quicksilver レンダラーまたはビューポート レンダラーで、波マップが正しく

レンダリングされません。  
• 非常に大きなシャドウ マップ(例：4096 x 4096)でレンダリング エラーが発

生することがあります。サイズを小さくすると(例：512 x 512)、このエラー

は解決されます。  
• GTS 8800 カードでは、一部のオブジェクトにちらつきが生じることがあり 

ます。  
• 多数のテクスチャを含むシーンのレンダリングでは、フレームのシーケンスの

レンダリング時にイメージのアーティファクトが発生する可能性があります。  
• 特定の状況で(通常は非常に複雑なマテリアル ツリーをコンパイルする場合)、

Vista オペレーティング システムおよび Windows 7 オペレーティング シス

テムで、ビデオ カードが強制的にリセットされることがあります。Windows 
XP 32 ビット オペレーティング システムは、不安定になる可能性があり 

ます。  
 

http://www.autodesk.com/3dsmax-mentalmill�
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• Quicksilver では、ビデオ カードのメモリ量によっては、特定のサンプリング

設定で黒いフレームがレンダリングされる場合があります。通常、これはメモ

リが 512MB に近い場合に発生します。  
• 特定の[レンダリング制御]可視性では、オブジェクト プロパティがサポートさ

れません。  
• ライトの[除外/含む]はサポートされません。  
• グループに反射を作成することはできません。これにはグループを分解する必

要があります。  
• Quicksilver では、頂点カラーはサポートされません。  
• 透明なレイヤは、1 つだけサポートされます。複数の透明オブジェクトが重 

なった場合、最初のオブジェクトだけが描画されます。  
• マテリアル エディタのサムネール背景はサポートされません。  
• コマンド ライン レンダリングでは、ガンマが適用されません。  
• Quicksilver では、以下のマップはサポートされません。  

o Combustion  
o 細胞  
o フラット ミラー  
o パーティクル エージ  
o パーティクル モーション ブラー  
o 薄壁屈折  
o 頂点カラー  

• Quicksilver では、以下のマップは完全にはサポートされません。  
o フォールオフ: ビュー方向に垂直/平行な方向でのみサポートされ 

ます。  
o グラデーション ランプ: 法線グラデーション タイプはサポートされま

せん。  
o ノイズ: 通常ノイズ タイプのみサポートされます。  
o 法線バンプ: 追加のバンプはサポートされません。  
o レイトレース: レイトレース マップの下の一部の調整パラメータはサ

ポートされません。  
o 反射/屈折: 反射/屈折マップの下の一部の調整パラメータはサポート

されません。  
• Quicksilver は、屈折をサポートしません。  
• Quicksilver は、特定の出力パラメータをサポートしません。この問題はすべ

てのマップ タイプに影響します。 

リボン • リボンのフォント サイズを変更すると、以下の問題が発生する可能性があり 

ます。  
o [カスタマイズ]ダイアログ ボックスが機能しなくなることがありま

す。新しいツリーを選択しても、プレビュー ウィンドウが更新されま

せん。  
o フォント サイズを変更した後、タブ名とパネル名以外のすべてのテキ

ストがリボンに表示されなくなることがあります。テキストは、メイ

ンのリボンではなく、フローティング パネルに再表示されます。  
o リボンを最小化してフォント サイズを変更し、[グラファイト モデリ

ング ツール]などのタブを選択すると、システムが機能しなくなる可

能性があります。  
o 選択解除されたジオメトリが選択されたままの状態になり、ギズモが

まだ選択されているかのように変換されます。  
• [タブ エクスポート]およびインコンテキスト UI 要素は、サードパーティ拡張

機能ではサポートされていません。  
• ツールクリップ(一部のリボン ツールチップにあるムービー)は、Windows XP 

64 ビット オペレーティング システムでは機能しません。  
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• ツールクリップは、特定のデュアルモニタ セットアップで再生できないことが

あります。  

ArchVision™ 社の 
RPC™プラグイン 

• (iPv6 ネットワークのみ) RPC プラグイン: RPC プラグインは、IPV6 を完

全にはサポートしていません。RPC プラグインの初回起動時、コンテンツ マ
ネージャの設定セクションでプラグインを設定しようとしても、ネットワーク 
カードが検出されません。 

• 回避策: iPv4 スタックを有効にし、[Rescan]をクリックします。これでネッ

トワーク カードが検出されるようになり、コンテンツ マネージャで RPC ファ

イルのパスなどの設定を行えるようになります。 
• 注: これは、iPv4 のみのネットワークまたは iPv6 デュアルスタック ネット 

ワークでは問題になりません。ただし、iPv6 ネットワークにバインドした場合

には、同じような問題が生じる可能性があります。  

 
前のバージョンで

保存  

• 以下を含むファイルに対して 3ds Max 2011 の前のバージョンでの保存機能

を使用すると、特定の問題が発生します。  
o プロキシを指定するコンテナ。  
o ロックされているノード上のベース オブジェクト 

(3ds Max 2010 でファイルを開いた場合、これらの項目は保持され

ません)。  
• RGB イメージを含むシーンを前のバージョンへのレンダリング出力として保存

すると、プログラムは保存された RGB 出力設定のロードに失敗します。  

SDK • SDK リリース情報については、『SDK Programmer's Guide』の「What's 
New: 3ds Max 2011」を参照してください。このガイドは、

<maxsdk_install_root>\help\3dsMaxSDKFull.chm にあります。  

スレート  
マテリアル  
エディタ  

• コンポジット マップでレイヤをドラッグ アンド ドロップする操作に 2 つの問

題が存在します。(1)ドラッグでレイヤを 1 番目のレイヤにしようとすると順

序が 1 つずれます。(2)ドラッグ アンド ドロップするレイヤにマップが割り

当てられている場合、これらのマップの余分なコピーがアクティブなビューに

表示されますが、コピーはレイヤにワイヤリングされません。このため、これ

らは安全に削除できます。  
• スレート マテリアル エディタを最小化しても、フォーカスがこのダイアログ 

ボックスに残ったままになります。このため、3ds Max のキーボード ショー

トカットが機能していないように見えます。使用していないときは、スレート 
マテリアル エディタを閉じることをお勧めします。  

• MetaSL サポート: mental mill に表示される追加の状態パラメータ(Normal 
と Position)は 3ds Max ではまだサポートされていません。  

• モーファー マテリアルは、スレート マテリアル エディタに完全に対応してい

ません。回避策: [モーフ オブジェクトを選択]ボタンは機能しません。代わり

に、モーファー マテリアル ワークフローでコンパクト マテリアル エディタを

使用します。  
• モーファー マテリアルは、既定値ではノードに 50 個のマテリアル スロット

を表示します。この数は減らすことができません。  
• コントローラ ノードを使用してパラメータ値を設定する場合、特定のケース

で、パラメータの範囲を超える値をインタフェースで設定できる場合がありま

す。ほとんどの場合、値は適切な値にリセットされます。  
• Windows テーマ CUI カラーを設定すると、[マテリアル/マップ ブラウザ]

で、3ds Max Design で選択操作が見づらくなることがあります。  
• マテリアル ディスプレイのタイプをアイコンのみに設定すると、スクロール 

バーが表示されなくなります。  
• 入力ワイヤをドラッグしながら Delete キーを押すと、プログラム エラーが発

生する可能性があります。  
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UVW アンラップ  • UVW アンラップを追加すると選択が失われます。回避策: 
Uv_SelectionFromBase のカスタム ボタンまたはホット キーを使用し 

ます。  

ビューポート  
キャンバス  

• ビューポート キャンバスで新しいテクスチャを作成する場合、[プリセット サ
イズ]の下に表示されているビットマップの最大サイズ(幅/高さ=2048)を超え

ないようにしてください。このサイズを超えると、エラー メッセージが表示さ

れ、最終的にビューポート キャンバスが終了することがあります。  
• ビューポート キャンバス レイヤ: [レイヤ]ダイアログ ボックスのリストでの

ブレンディング オプションの参照では、上下カーソル キーによる操作はサ 

ポートされていません。  
• ビューポート キャンバスでは、マップに表示されるのは UV だけでタイリング 

パラメータは表示されません。小さなビットマップ タイルを使用してオブジェ

クトにペイントしようとすると、パフォーマンスに影響することがあります。

このため、タイリングなしまたは非常に少数のタイリングのみの UV を使用

し、[リアル-ワールド マップ サイズ]をオフにしてペイントすることをお勧め

します。  
• ビューポート キャンバスは、テクスチャ パスの履歴をサポートしていま 

せん。  
• [塗りつぶし]ツールで MAXScript エラーが発生する可能性があります。  

Windows 7  
オペレーティング 
システム  

• Windows 7 オペレーティング システムでは、既定値でスナップ機能が有効に

なっています。これは無効にすることもできます。この機能は便利ですが、有

効になっているとダイアログ ボックスをよく読まずに安易に操作を確定してし

まう恐れがあります。  
1. Windows 7 で、[マウスのプロパティ]ダイアログ ボックスを開きま

す。  
2. [ポインター オプション]タブを選択します。  
3. [動作]の下で、[ポインターを自動的に既定のボタンの上に移動する]

チェックボックスをオフにします。  
4. [OK]をクリックして[マウスのプロパティ]ダイアログ ボックスを閉

じます。  
5. セキュリティ上の理由から、また意図しないクリックを防ぐため、こ

の機能を有効にしても[ユーザーアカウント制御設定]ダイアログ ボッ

クスが表示されている間は、マウス ポインタが移動しません。  
• 3ds Max 2011 または 3ds Max Design 2011 を 3ds Max 2010 または 

3ds Max Design 2010 と同時にインストールするには、3ds Max 2010  
ホットフィックス 7 (2009.09.22) をインストールする必要があります。この

ホット フィックス

はhttp://usa.autodesk.com/adsk/servlet/item?siteID=1169823&id=14045685 で
ダウンロードできます。  

XMSL ファイル  • 特定のケースで、mental ray レンダラーを使用しているときに DirectX マテ

リアルに XMSL をロードすると、ソフトウェアが機能しなくなる可能性があり

ます。回避策: 3ds Max / 3ds Max Design でスキャンライン レンダラーま

たは Quicksilver レンダラーを使用します。  
• [マテリアル]/[XSML ファイルとして書き出し]を使用すると、シェーダ  

ツリーに保存されたパラメータが失われます。  
• 書き出された XMSL ファイルに、正しいパラメータ値が含まれません。  

http://usa.autodesk.com/adsk/servlet/index?siteID=1169823&id=13214471�
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Autodesk® MotionBuilder 2011 
 

 

 

 リリース情報 

このリリース情報には、Autodesk MotionBuilder 2011 ソフトウェア製品

およびドキュメントに関する最新の情報が記載されています。 
Microsoft Windows 用 Autodesk MotionBuilder 2011 は、オートデスク 
認 定 販 売 パ ー ト ナ ー か ら お 買 い 求 め い た だ け ま 
す。 http://www.autodesk.co.jp/motionbuilder にアクセスして、ページ上

部にある「購入するには」リンクをクリックしてください。 
MotionBuilder サブスクリプションにご契約いただいているお客様は、

Autodesk Subscription センターから Autodesk MotionBuilder 2011 ソフ

トウェアをダウン ロードいただけます(Subscription Gold Support のお

客様も同様)。http://www.autodesk.co.jp/subscription を参照してください。 

MotionBuilder ソフトウェアまたはダウンロードに関する詳細 

は、http://www.autodesk.co.jp/motionbuilder を参照してください。 

MotionBuilder 2011 の ド キ ュ メ ン ト に 対 す る 更 新 情 報

は、http://www.autodesk.co.jp/motionbuilder-documentation を参照してくだ

さい。  

MotionBuilder を初めて使用する方もそうでない方も、上級ユーザもソフ

トウェア開発者の方も、オートデスクの以下の Web サイトを是非ご覧

になってみてくだ さい。  
http://www.autodesk.com/motionbuilder-learningpath 
http://www.the-area.com  
http://www.autodesk.co.jp/fbx  
http://www.autodesk.com/developmotionbuilder  
http://www.autodesk.co.jp/qual-charts  

Autodesk Entertainment Creation Suite に 関 す る 詳 細 

は、http://www.autodesk.co.jp/entertainmentcreationsuites-documentation を参

照してください。 

Autodesk の ソ フ ト ウ ェ ア 体 験 版 に 関 す る 詳 細 

は、http://www.autodesk.co.jp/me-download を参照してください。 
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このリリースの新機能と機能強化 
このセクションでは、MotionBuilder 2011 製品リリースの新機能と拡張機能について

説明します。 

ファイル I/O のサポート 
このリリースは、ファイル I/O 処理のメカニズムとして FBX SDK 7.0 を採用す

ることで、オートデスクの他の  3D ソフトウェア製品 (Autodesk® Maya®、

Autodesk® 3ds Max® など)との最高の互換性を実現しています。ファイル I/O に
関する主な変更点は次のとおりです。 

 MotionBuilder 2011 では、旧バージョンの MotionBuilder で作成され

た .fbx ファイルも開くことができます。ただし、MotionBuilder 
2011 で保存すると、デフォルトではすべてのファイルが最新の FBX 
ファイル フォーマット(バージョン 7.0)で保存されます 

 MotionBuilder 2011 で作成した .fbx ファイルを旧バージョンの FBX ファイル 

フォーマットで保存(エクスポート)するには、メイン メニューから Python  
Tools > FBX Export > FBX 2010 を選択します。  

 
MotionBuilder 2011 で作成したファイルを FBX バージョン 2010 のファイル 

フォーマットで保存すると、オートデスクのバージョン 2010 の各種アプリケー

ションで使用できるようになります。  

ファイル I/O の制限事項を参照してください。 
 FILE > OPEN を選択して、.fbx ファイルを開いたりインポートできるようにな

りました。それに伴い、File メニュー オプションの「FBX Plug-in Import」と
「Import」が廃止されました。  

 File > Merge を選択して、.fbx ファイルをマージできるようになりました。それ

に伴い、File メニュー オプションの「FBX Plug-in Merge」が廃止されました。  

 File > Motion File Import で、モーション キャプチャ ファイルをインポートでき

るようになりました。それに伴い、File メニュー オプションの「Import」が廃止さ

れました。  

 File > Motion File Export で、モーション キャプチャ ファイルをエクスポートで

きるようになりました。それに伴い、File メニュー オプションの「Export」が廃

止されました。  

ファイル I/O の制限事項を参照してください。 
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アニメーション レイヤの機能強化  
FCurves ウィンドウの Layer ペインが、アニメーション レイヤ エディタに変更

されました。このアニメーション レイヤ エディタを使用して、アニメーション 
レイヤを作成、選択、管理できます。また、レイヤの順序を操作したり、レイヤ

のペアレント、ミュート、ソロ、ロックなどの設定も行えます。さらに、各種レ

イヤ ブレンド モード(Additive、Override など)やレイヤ アキュムレーション  
モードも選択できます。各レイヤの Weight 値を変更したりアニメートして、最

終的なアニメーションでのそのレイヤのアニメーションの影響度を定義すること

もできます。  
アニメーション レイヤ エディタでは、選択中のレイヤは緑色で表示されるよう

になり、カレント レイヤが区別しやすくなりました。  
さらに、新しく FBAnimationLayer クラスが追加され、アニメーション レイヤ機

能がエクスポーズされています。  

アニメーション レイヤの命名規則  
MotionBuilder と Maya との相互運用性の強化に伴い、アニメーション レイヤ エ
ディタのレイヤのデフォルトの命名規則が変更されました。「Base Layer」が

「BaseAnimation」、「Layer 1」が「AnimLayer1」に変更になり、新しく作成し

たレイヤの名前は「AnimLayer2」、「AnimLayer3」...のようになります。また、

レイヤを複製した場合も同じ命名規則が適用されます。  
注: 旧バージョンのアニメーション レイヤが含まれているファイルを開いた場合

は、レイヤの名前は自動的には変更されません。たとえば、「Layer 1」レイヤは

「Layer 1」のままです。このファイルを Maya にインポートすると、「Layer 1」
は「Layer_1」という名前に変更されます。再び MotionBuilder にインポートする

と、レイヤ名は「Layer_1」のままになります。  

マテリアルとテクスチャの機能強化  
マテリアルとテクスチャの機能が大幅に強化されました。ここでは、主な機能強

化について大まかに説明します。  
マテリアル、テクスチャ、シェーダ アセットが Asset Browser の  Shading 
Elements ディレクトリにまとめられました。Shading Elements フォルダには、

Materials アセットの他に、マテリアルと組み合わせて使用するテクスチャ ア 
セットおよびレイヤ構造のテクスチャ アセットがあります。Shading Elements 
ディレクトリの下の Global Lighting Texture フォルダには、シェーダと組み合わ

せて使用する各種テクスチャ アセットとレイヤ構造のテクスチャ アセットがあ

ります。同じディレクトリの下の Shaders フォルダには、カスタム シェーダを

含むすべてのシェーダが格納されます。 

マテリアル  
Material Settings に新しいプロパティと設定が追加されました。新たに追加され

たプロパティは Displacement、Bump Map、Normal Map です。新しい設定には、

Intensity (または Factor)設定や、テクスチャ リストとボタンなどがあります。
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Intensity の各種設定を使用すると、各プロパティがマテリアルの結果に与える影

響の度合いを調整したりアニメートすることができます。テクスチャ リストとボ

タンは、各プロパティにテクスチャをアタッチ/デタッチする場合に使用します。 
注: Diffuse、Bump Map、Normal Map 以外のマテリアル プロパティにテクス 
チャをアタッチして結果を表示するには、カスタム シェーダ(Open Reality® SDK 
を使用して作成できます)が必要になります。 
Material Settings は、基本的なマテリアル設定と高度なマテリアル設定の 2 つの

カテゴリに分かれています。高度な設定の結果を Viewer に表示するためには、

適切なシェーダが必要になります。たとえば、Bump Map プロパティにテクス 
チャをアタッチした結果を表示するには、モデルに Bump Map シェーダまたは 
Dynamic Lighting シェーダを適用する必要があります。また、Specularity テクス

チャや Reflectivity RGB といった一部の高度な設定は、結果を Viewer ウィンド

ウに表示するためには Open Reality SDK を使って作成したカスタム シェーダを

適用する必要があります。なお、高度な設定は、Advanced Mode オプションを

使用して有効/無効を切り替えられます。  
Autodesk 3ds Max をはじめとする 3D モデリング ソフトウェアからモデルをイ

ンポートすると、1 つのモデルに複数のマテリアル(マルチ/サブオブジェクト マ
テリアルなど)が適用されている場合があります。それらのマテリアルは Scene 
Browser にリストされ、モデルにアタッチされます。MotionBuilder ではモデル

と一緒にすべてのマテリアルをインポートできますが、その場合はモデル上に各

マテリアルに対応するポリゴン領域が設定されている必要があります。各領域に

適用されているマテリアルは修正、置き換え、削除できます。ただし、この領域

は 3D モデリング ソフト側で設定するもので、MotionBuilder では変更できま 
せん。  

テクスチャ  
Asset Browser では、マテリアル、テクスチャ、シェーダのアセットがそれぞれ

にまとめられました。さらにテクスチャは、マテリアルにアタッチするテクスチ

ャとグローバル ライティング テクスチャの 2 つのカテゴリに分かれています。

旧バージョンの MotionBuilder では、テクスチャ アセットはモデルに直接アタッ

チしていました。今回のリリースでは、モデルの外観に色やディテールを加える

ためのテクスチャは、Diffuse や Bump Map といったマテリアル プロパティにア

タッチします。マテリアルにアタッチするテクスチャを作成するには、Asset 
Browser の Shading Elements フォルダからアセットをドラッグします。ドラッ

グしたテクスチャは、Viewer のモデル上でドロップするか、Scene Browser の
マテリアル上にドロップします。続いて、表示されるメニューを使用して、テク

スチャのアタッチ先とするマテリアル プロパティを選択します。  
注: Diffuse、Bump Map、Normal Map 以外のマテリアル プロパティにテクスチ

ャをアタッチして結果を表示するには、カスタム シェーダ(Open Reality SDK を
使用して作成できます)が必要になります。 
グローバル ライティング テクスチャはモデルに直接適用します。このタイプの

テクスチャは Shadow Map、Lighted、Reflection といった各種シェーダによって

生成され、シェーダと相互作用します。グローバル ライティング テクスチャを
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作成するには、Shading Elements フォルダを展開して、Global Lighting Texture 
フォルダからアセットをドラッグします。 
さらに、新しくレイヤ構造のテクスチャ アセットが追加されました。レイヤ構造

のテクスチャ アセットを使用すると、複数のテクスチャをブレンドしたものを 1 
つのテクスチャのように調整することができます。Layered Texture 設定 は、(一
般的な設定を行うための) Texture Settings ペインと、テクスチャの追加、管理、

複数のテクスチャのブレンドを行うための Layer Settings ペインで構成されてい

ます。  
モデルに複数の UV セットが定義されている場合は、Texture Settings の UV Set 
フィールドでそれらの UV セット(マップ チャンネルとも呼ばれます)を選択でき

ます。また、Rotation の設定も機能が追加されています。  
注: Use Material オプションは廃止されました。Texture Type メニューは作成し

たテクスチャのタイプを表示する目的で残されています。  

マテリアルとテクスチャの処理  
マテリアルとテクスチャの処理が新しくなったことで、FBX ジオメトリ モデル

がサポートされ、Autodesk Maya、3ds Max との相互運用性が強化されました。

また、シェーダのパフォーマンスも向上しています。  
テクスチャ/マテリアル モデルで、現在ドロップされているチャンネルもイン 
ポートできるようになりました。また、すべてのマテリアルがマッピング チャン

ネルを持つようになったことで、マテリアルの各コンポーネントにテクスチャを

適用できるようになりました。この変更に伴い、SDK の FBFastTessellator が廃

止されました。  

Python Tools メニュー  
Python Tools メニューを使用して Python ツールにアクセスできるようになりま

した。  

 
バッチ  ツール  スクリプトと、MotionBuilder 2011 のファイルを  FBX 2010  
フォーマットで保存するための FBX Export オプションが Python ツールに追加

されました。  
注: FBX 2010 フォーマットのファイルは MotionBuilder のファイルとは異なりま

す。そのため、MotionBuilder 固有の情報(Story 情報、デバイスなど)は、 Python 
Tools > FBX Export または FBX コンバータを使用した場合には削除されます。 

ジョイントの物理プロパティの強化  
ジョイント ソルバに、Disable collision と Creation type の 2 つのオプションが

追加されま した。  
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Disable Collision  
新しく追加された Disable Collision オプションを使用すると、ソルバ処理中

の衝突エフェクトを無効にすることができます。この機能により、リジッド 
ボディ オブジェクト同士を衝突させるか、あるいは互いに貫通させるかをコ

ントロールできます。Disable Collision オプションをオンにすると、ソルバ処

理の対象のリジッド ボディ オブジェクト同士は、衝突して相互に作用し合い

ます。Disable Collision オプションをオフにすると、別のリジッド ボディ オ
ブジェクトに衝突したときのリジッド ボディのジョイント ソルバへの反応が、

処理の対象から除外されます。このオプションを使用すればソルバ処理中の

衝突作用を無効にできるため、リジッド ボディ オブジェクト同士をジョイン

トしたいが、衝突はさせたくないという場合に便利です。  

Creation Type  
ジョイント ソルバに追加された Creation Type メニューでは、ジョイント ソ
ルバのデフォルトの動作か、ソルバが有効に設定された時点でジョイント作

用を有効にするかを選択できます。旧バージョンの MotionBuilder では、ジョ

イント作用はソルバを Online に設定した瞬間に作成されていました。そのた

め、ソルバの初期化の時点で、対象のリジッド ボディ オブジェクトが正しく

配置されている必要がありました。今回のリリースでこの動作を使用するに

は、Joint > Setup > Creation Type メニューから At Solver Initialization を選択

します。あるいは、シミュレーションの開始時以外の特定のタイミングで 
ジョイント ソルバを有効にしたい場合は、Joints > Setup > Creation Type メ
ニューから At Enable を選択します。この新しいジョイント オプションを使

用すれば、シミュレーションの開始時以外のタイミング、たとえばキャラク

タが何かをキャッチする瞬間などにジョイントを有効にすることができます。

この動作は、ジョイント作用にキーを設定してアニメートする(特定の時間が

経過してからコンストレインをオンにする)のとよく似ています。  

Dynamic Lighting シェーダ  
Dynamic Lighting シェーダの設定に、Transparency Factor スライダと Affecting 
Lights フィールドの 2 つの項目が追加されました。  

Transparency Factor スライダ  
Transparency Factor スライダでは、Dynamic Lighting シェーダに対する不透

明度の操作またはアニメートを行います。デフォルトでは 1.00 に設定されて

います。マテリアルの透明度の設定と Dynamic Lighting シェーダの透明度の

値が相互に作用し、最終的な結果に影響を及ぼします。  

Affecting Lights フィールド  
Affecting Lights フィールドでは、Dynamic Lighting シェーダが適用されてい

るオブジェクトを照明するライトを指定します。OpenGL の制限により、

MotionBuilder シーン内でも使用できるライトは最大 8 個のため、それ以上必
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要な場合には Affecting Lights フィールドを使用してシーンにライトを追加で

きます。  
シーン内の任意のライトを、Alt キーを押しながら Affecting Lights フィール

ドにドラッグします。フィールドの横の Affecting Lights ボタンをクリックし

て、アセット リストを表示し、シーン内のライトから選択することもでき 
ます。  
注: Affecting Lights フィールドには Selective Lighting シェーダと同じ機能が

あります。Selective Lighting シェーダと Dynamic Lighting シェーダを一緒に

使用しないでください。問題が発生する場合があります。代わりに、

Dynamic Lighting シェーダの Affecting Lights フィールドを使用します。  

時間非依存のキーフレーム  
Maya で作成したアニメーションを MotionBuilder で編集して再び Maya に戻し

たときに、Bezier-Auto タイプと Bezier-Clamp タイプのキーが保持されるように

なりました。  
Bezier-Auto および Bezier-Clamp キーフレーム タイプに新しく「時間非依存」

モードが追加されました。この新しい「時間非依存」タイプのキーは、アニメー

ションを Maya にエクスポートする際に「固定」(User)キーに変換されません。

まったく同じ(Maya で正確に一致する)キー タイプが保持されます。「時間非依存」

モードの Bezier-Auto キーは Maya ではスプライン、Clamp キーは Maya ではク

ランプ キーになります。  
なお、旧バージョンの MotionBuilder で作成された Bezier-Auto および Bezier-
Clamp キーフレームの動作も引き続きサポートされています。これらのキーフ 
レームは、Maya にエクスポートすると従来どおり「固定」(User)キーに変換さ

れます。  
注: キーフレームの補間を変更するとキーは「リセット」され、以降は新しい

「時間非依存」モードが適用されます。  

カメラのバック プレート/フロント プレート  
イメージ ファイルとビデオ ファイルが、カメラのバック プレートまたはフロン

ト プレートに直接アタッチされなくなりました。イメージまたはビデオ クリッ

プをカメラのバック プレートあるいはフロント プレートに適用するには、テク

スチャをカメラ上にドラッグするか、Camera 設定の Background Texture フィー

ルド内にドラッグします。  

デフォルト レイアウトの変更、追加  
デフォルト レイアウトの見直し、変更が行われました。さらに、1,920 × 1,200 
の画面解像度に対応した新しいデフォルト レイアウトも追加されています。  
デフォルト レイアウトの変更点は次のとおりです。  

 Dynamic Editor ウィンドウが廃止され、代わりにアニメーション レイヤ エディ

タを使用するようになりました。  
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 Editing レイアウトの Navigator ウィンドウの Motion Blend タブが廃止されまし

た。ただし、Motion Blend ウィンドウには MotionBuilder の Window メニュー

からアクセスできます。  
 Creation、Animation、Editing、Preview、Story の各デフォルト レイアウトに、

画面解像度 1,920×1,200 のモニタ用のデフォルト レイアウト設定が追加され

ました。  
 

デフォルト  レイアウトは、 MotionBuilder のルート  ディレクトリの 
\bin\config\Layouts\base に格納されます。これらのデフォルト レイアウトを、

ア プ リ ケ ー シ ョ ン の 初 回 起 動 後 に  C:\Users\< ユ ー ザ 
名>\AppData\Local\Autodesk\MB2011 \config\Layouts\Base に追加することもで

きます。  
カスタム レイアウトは、Vista と Windows 7 OS の場合は C:\Users\<ユーザ  
名>\AppData\Local\Autodesk\MB2011\config\Layouts に、Windows XP OS の場

合は MotionBuilder のルート ディレクトリの \bin\config\Layouts に保存され 
ます。  
注: MotionBuilder 2011 Release Candidate を Windows Vista または Windows 7 
オペ レーティング システム上にインストールした場合は、MotionBuilder 2011 
Release Candidate の 初 回 起 動 前 に 、 必 ず  C:\Users\< ユ ー ザ 
名>\AppData\Local\Autodesk に保存されている MB2011 ユーザ データを削除し

てください。そうしないと、ユーザ データに保存されている古いデフォルト レ
イアウトが新しいデフォルト レイアウトで上書きされません。  

ボーンのモーション キャプチャ  
モーション キャプチャ センサ データをモーション キャプチャ ハードウェアで

直接、キャラクタのスケルトン ノードに関連付けることができるようになりまし

た。このメカニズムについては、新しく追加された mocap のサンプル スケルト

ン、deviceskeleton を参照してください。  

Python Batch Tool のスクリプト  
新しく Python UI ベースのバッチ ツール スクリプトが追加されました。 Python 
コ ー ド (BatchTool.py) は 、 MotionBuilder の ル ー ト  デ ィ レ ク ト リ の 
bin\config\PythonStartup\ フォルダにあります。  
Python Batch Tool には、MotionBuilder の  Python Tools メニュー、または 
Python Editor Tool Manager ボタンからアクセスできます。  

新しい FBFCurve 関数  
FBFCurve::KeyDelete を使用すると、FBFCurve::KeyRemove を繰り返し使用す

るよりもすばやくインデックス範囲内のキーを削除できます。  
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.cgfx シェーダ ファイルの埋め込み  
ファイルを保存するときに、Save File ダイアログ ボックスの Embed Medias オ
プションをオンにして、.fbx ファイルに CgFX シェーダ メディア ファイルを埋

め込むことができるようになりました。メディアが埋め込まれたファイルを開く

と、メディア ファイルが .fbm フォルダに抽出され、CgFX シェーダ設定のパス

がその .fbm フォルダをポイントするように更新されます。  

新しい Shape Editing インタフェース  
Shape Editing インタフェースが ORSDK と Python に公開されました。使用方法

については、ShapeCreation.py を参照してください。  

新規関数 FBComponent::HardSelect() の追加  
Viewer と Navigator の両方で項目を選択し、すぐに編集できるように右側のペイ

ンに表示します。  

サンプル コードの追加  
立方体を作成し、その立方体の移動、回転、スケール プロパティをカスタム  
キ ーイ ング  グ ルー プに 追加す る方法 を例 示した サンプ ル  コー ド 
FBKeyingGroupLocal.py が追加されました。  

オートデスク標準のインストールおよびライセンシング  
このリリースでは、他のオートデスク製品との一貫性およびユーザエクスペリエ

ンスの向上を図る目的で、オートデスク標準のインストールおよびライセンシン

グ スキームがサポートされています。  

MotionBuilder 2011 リリースでのその他の変更点  
ここでは、MotionBuilder のその他の変更点について説明します。  

Story ツールの最適化  
全体的な安定性とパフォーマンスの向上を目指して、現在、Story ツールの最適

化が進められています。  
今回のリリースでは、MotionBuilder エンジンで Story ツールの評価が行われるよ

うになりました。  

アップデートされた Qt のサポート  
本リリースの MotionBuilder では、Qt™ バージョン 4.5.2 がサポートされています。 
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アップデートされた Python のサポート  
MotionBuilder のライブラリは、Python ® バージョン 2.6.4 (2009 年 10 月リリー

ス)にアップグレードされています。これは現行の Autodesk Maya 製品で使用さ

れているものと同じバージョンです。  
このリリースには(前回のリリースと同様に)完全な Python パッケージが付属し

ているため、http://www.python.org からパッケージをダウンロードする手間をか

けなくても、標準の Python インストールに含まれている各種機能を利用でき 
ます。  

NVIDIA PhysX のサポート  
本リリースでは、NVIDIA® PhysX® ソルバ プラグインがサポートされています。  
注: このプラグインを使用するには、NVIDIA PhysX ドライバが必要です。  

Perforce のサポート  
本リリースでは Perforce® がサポートされています。  

Customer Involvement Program のサポート  
今回のリリースで、CIP データをプレビューできるようになりました。CIP デー

タをプレビューするには、MotionBuilder の  Help メニューから  Customer 
Involvement Program を選択し、Autodesk Customer Involvement Program ウィ

ンドウの右下にある Preview MY CIP Data をクリックします。  

Windows 7 のサポート  
今回リリースの MotionBuilder は、Microsoft Windows® 7 Professional 64 ビット 
OS (オペレーティング システム)をサポートしています。  

IPv6 のサポート  
このリリースは、Internet Protocol version 6 (IPv6、IPv4 の後継)をサポートして

います。IPv4 では 32 ビット アドレスしか使用できませんでしたが、IPv6 では 
128 ビット アドレスが利用できます。  
注: IPv6 はデフォルトでオンになっています。  
IPv6 の制限事項を参照してください。  

解決された問題  
MotionBuilder 2011 製品リリースで解決された問題について説明します。  

  

http://www.python.org/�
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新しいクリップへのプロット  
「Process Tracks/Subtrack To New Clip」を使用したときに、処理対象のクリッ

プに、選択したクリップのすべてのアニメーションが含められるようになりま 
した。 

Story のカスタム TimeWarp カーブ  
Story クリップの TimeWarp カーブの編集時に、TimeWarp カーブが正しく描画

され、編集後の Clip In および Mark In 設定と一致するようになりました。  
クリップの長さと、クリップに含まれているオリジナルのアニメーション データ

の長さが自動的に識別されます。クリップを編集(たとえば、クリップを短くし

たりループするなど)しても、オリジナルのアニメーション データの長さは保持

されます。TimeWarp カーブ上に、Clip In と Clip Out を示す短い縦線(図の B を
参照)が表示されます。  

 

複数のクリップの分割  
Story ウィンドウで Razor ボタンをクリックして複数のクリップを同時に分割で

きるようになりました。複数のクリップを分割するには、選択したクリップの上

にタイムライン インジケータを移動して、Razor ボタンをクリックします。選択

していないクリップは分割されません。  

Story の Blend プロパティ  
Story の Blend プロパティが正しく保存されるようになりました。旧バージョン

では、Blend プロパティの編集内容は破棄されていました。  

C3D ファイルのインポート  
負のフレームにアニメーションが設定されている C3D ファイルをインポートし

たときに MotionBuilder が不安定になるという問題が解決されました。  
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CgFx シェーダのパラメータ  
CgFx シェーダのパスを変更したときにシェーダのパラメータがリセットされる

という問題が解決されています。CgFx シェーダの設定に、Merge Parameters オ
プションが追加されました。CgFx シェーダをロードまたは再ロードする際に 
Merge Parameters オプションをオンにすると、シェーダのプロパティの設定

と .dds ファイルへの参照が保持されます。Merge Parameters オプションを無効

にすると、これらの設定はクリアされます。  

コンストレインされたライトを Affecting Lights として選択した場合  
コンストレインにライトが含まれている場合に、それらのライトを Dynamic 
Lighting シェーダの Affecting Lights として選択すると MotionBuilder がクラッ 
シュするという問題が解決されました。  

Story ウィンドウの補助エフェクタ  
Story ウィンドウで Additive に設定された Character トラックに補助エフェクタ

が含まれている場合に、ファイルを保存して開き直しても、補助エフェクタの 
Reach 値とピン(固定)の値が保持されるようになりました。以前は、補助エフェ

クタの影響が失われていました。  

Story ウィンドウのクリップの Mark In/Mark Out 値  
Story ウィンドウでカレント テイクからクリップを挿入し、トリムしてコピー & 
ペーストしたときに、編集後の Mark In 値と Mark Out 値が保持されるようにな

りました。以前は、ペーストしたクリップの Mark In 値と Mark Out 値が失われ

ていました。  

Relation コンストレインでのボックス コネクタの使用  
Relation コンストレインのボックス コネクタをクリックして Delete キーを押す

と、MotionBuilder がクラッシュするという問題が解決されました。  

Relation コンストレインのベジェ カーブ ボックス  
Relation コンストレインのベジェ カーブ ボックスの使用時に Global から Local 
に切り替えると接続が再割り当てされるという問題が解決しました。今回のリ 
リースでは、ベジェ カーブ ボックスの Translation コネクタが Vector コネクタ

に変更されています。  

Use Constant Key Reducer オプション  
Preferences ウィンドウの Filters プリファレンスで Use Constant Key Reducer 
オプションを無効にすると、Constant Key Reducer と Runtime Constant Key 
Reducer の両方がオフになります。  
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Scene Browser でのテイクの選択  
Navigator の Scene Browser でテイクを選択したときに、Transport Controls の
ズーム バーが各テイクの長さに合わせて正しく表示されるようになりました。以

前は、前に選択されていたテイクの長さに合わせてズーム バーがリサイズされて

いましたが、その問題は解決されました。  

ズーム バーをリサイズしてシーンをマージした場合  
Transport Controls のズーム バーのサイズを変更してから、テイクが含まれてい

るファイルをマージすると、以前はズーム バーがタイムラインの長さいっぱいに

リセットされていましたが、今回のリリースでは変更後のサイズが維持されるよ

うになりました。  

Pose Controls とネームスペース  
同じネームスペースを使用するキャラクタが含まれているシーンをマージしたと

きに、保存されているポーズが正しく機能するようになりました。ポーズを両方

のキャラクタにペーストしても、期待どおりの結果が得られます。キャラクタ エ
クステンションを伴うポーズでも正しく機能します。  

Producer Top カメラの Far Plane  
Producer Top 正射投影カメラを使用する際に、Camera Settings の Far Plane 値
を使って、クリッピング平面を Y 軸の 4000 よりも遠い位置に設定できるように

なりました。前のバージョンでは、Far Plane 値の上限は 4000 でした。  

レイヤのインポート:加算スケールの重ね合わせ （Scale Additive 
Accumulation）モード  
MotionBuilder は  Maya の 加 算ス ケ ールの 重 ね 合 わせ （ Scale Additive 
Accumulation）モードが使用されているアニメーション レイヤをサポートしてい

ないため、このタイプのレイヤが使用されているシーンをインポートしようとす

ると警告のダイアログ ボックスが表示されるようになりました。その場合は、

Maya の乗算スケールの重ね合わせ（Scale Multiply Accumulation）モードを使用

してファイルをエクスポートし直すか、レイヤをベイクすることでアニメーショ

ンの外観を忠実に保持できます。  

ローカル キーイング グループの再ロード  
カスタムのローカル キーイング グループを作成してファイルを保存し、再ロー

ドしたときに MotionBuilder がクラッシュするという問題が解決されました。  

OR SDK および Python の FBPlotPopup  
Plot オプションの設定に使用するダイアログ ボックスが、OR SDK と Python に
公開されました。FBPlotPopup でダイアログ ボックスを表示して、ユーザの 
FBPlotOptions を取得することができます。 
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カスタム ユーザ オブジェクトのプロパティへのアクセス  
Python あるいは C++ で、カスタムの C++ ユーザ オブジェクトのプロパティに

アクセスできるようになりました。  

OR SDK の FBProgress クラス  
FBProgress クラスに割り込みコールバック関数が公開され、処理を中断できる

ようになりました。使用方法については、FBProgress.py を参照してください。

また、FBProgress を使用して作成したプログレス バーの UI 表示を、Esc キー

を押して中断することもできます。 

OR SDK のサンプル constraintposition  
OR SDK の サ ン プ ル  constraintposition が 修 正 さ れ ま し た 。

orconstraintposition.cxx の SetupAllAnimationNodes() が変更され、カスタム コン

ストレイン上にローカル FBAnimationNodes を作成できないという問題が修正さ

れました。  

FBFCurve の新しい関数  
FBFCurve::KeyDelete を使用すると、FBFCurve::KeyRemove を繰り返し使用す

るよりも効率的にインデックス範囲内のキーを削除できます。この新しい関数に

ついての詳細は、CopyAninamation.py を参照してください。  

Python の FBProgress オブジェクト  
FBProgress:: ProgressDone() の Python 版を使用して、タスクの完了後に UI の
プログレス バーをリセットできるようになりました。  

Python エクスポージャ使用時の FBGeometry の問題  
FBGeometry::VertexGet と FBGeometry::VertexUVGet の Python 版が正しく機能

するようになりました。  

FBApplication::FileAppend()  
この関数は以前のリリースでは正しく機能しませんでしたが、今回のリリースで

修正されま した。  

Python での BoxLayout  
BoxLayout 内のコントロールを、Python の AddRelative メソッドを使用してセン

タリングできるようになりました。 詳細は、新しくなった BoxLayout.py スクリ

プトを参照してください。  
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Python Editor の自動補完  
Python Editor の自動補完機能の使用時に、場合によってコンソール画面内に収ま

らないという問題が解決されました。  

Python のマルチバイト文字  
MotionBuilder 以外のソフトで編集したスクリプトは、UTF-8 でエンコードしな

いと、MotionBuilder の Python Editor で開くことはできません。Python では、

デフォルトではすべてのスクリプトが ASCII で記述されているものとみなされま

す。Unicode を使用するには、スクリプトの 1 行目または 2 行目でエンコードを

宣言する必要があります(http://www.python.org/dev/peps/pep-0263/ を参照)。 

C++ の FBVector4d  
MotionBuilder のバージョン 2009 とバージョン 2010 では、C++ の FBVector4d 
のカスタム プロパティを作成することはできませんでした。現在のバージョンで

は、この問題は修正されています。  

Optical Device Template の C++ サンプルの修正  
OR - Optical Device Template が新しくなりました。MotionBuilder のバージョン 
2009 とバージョン 2010 では入力データ ストリームが光学式マーカにマッピン

グされませんでしたが、今回のバージョンではこの問題が修正されています。 

FBSpread による値の設定  
以前のバージョンの MotionBuilder では、FBSpread では SetCellValue でセルの

値を設定することしかできませんでした。特定の 'Style' 列挙を選択した後で値を

設定することはできませんでした。現在のバージョンでは、この問題は修正され

ています。  

未解決の問題と制限事項  
ここでは、MotionBuilder 2011 ソフトウェア製品リリースにおける、特に重要な未解

決の問題と制限事項について説明します。  

ファイル I/O  
ここでは、ファイル I/O に関する制限事項を紹介します。  

 MotionBuilder 2011 で保存した FBX ファイルは、旧バージョンの 
MotionBuilder ではロードできません。  
この問題は、MotionBuilder 2011 で保存した .fbx ファイルをメイン メ
ニューの Python Tools > FBX Export > FBX 2010 を使用して旧バー 
ジョンの FBX フォーマットでエクスポートするか、Autodesk FBX コン

バータを使用することで対処できます。  
注: FBX Converter は、http://www.autodesk.co.jp/fbx からダウンロード

できます。  
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 Python Tools > FBX Export > FBX 2010 ツールまたはFBX コンバータ 
ツールを使用してエクスポートした FBX ファイルは FBX SDK ファイ

ルであり、MotionBuilder のファイルとは異なります。したがって、

MotionBuilder 固有の情報(Story 情報、デバイスなど)は削除されます。  
 FBX バージョン 2010 のファイル フォーマットは、MotionBuilder 2011 

のアニメーション レイヤをサポートしていません。  

Templates ディレクトリの変更  
Asset Browser から Templates ディレクトリを変更すると、次回 MotionBuilder 
を起動できなくなります。  
Templates ディレクトリの変更後に、MotionBuilder を起動できるようにするため

には、Windows 7 と Windows Vista OS の場合は、起動する前に C:\Documents 
and Settings\<ユーザ名>\Application Data\Autodesk\MB2011 あるいは C:\Users\<
ユ ー ザ 名 >\AppData\Local\Autodesk\MB2011 ( ま た は  MB2011x64) の 
MotionBuilder ユーザ データを削除する(Templates ディレクトリに対する変更を

無効にする)必要があります。  
Windows XP Professional OS の場合は、Templates ディレクトリの変更後に起動

するには、C:\Program Files\Autodesk\Autodesk MotionBuilder 2011\bin\config に
保存されている設定ファイル  <コンピュータ名>.History.txt を削除してくだ 
さい。  

FBFbxOptions によるネームスペースの指定  
旧バージョンの MotionBuilder では、FBApplication::FileAppend を使用してネー

ム スペースを指定していました。今回のバージョンでは、ネームスペースは 
FBFbxOptions::CustomImportNamespace を使用して指定します。 

Relation コンストレインのレシーバ タイプのボックス  
アニメーション ノードのセンダー ボックスとレシーバ ボックスの両側にローカ

ル ノードを接続すると、問題が生じます。この問題は、グローバルに設定するこ

とで対処できます。  

IPv6 ネットワーク  
ここでは、IPv6 ネットワークに関連する問題を紹介します。  

• Windows 7 と Windows Vista の間では、IPv6 のネットワーク サーバとネッ

トワーク クライアントが正しく機能しません。  
• Windows® XP Professional OS 用の Autodesk Network License Manager に

は IPv6 パッケージは付属しません。  
• IPv6 上でネットワーク ライセンスのアクティベーションを行うと、ライセ

ンス サーバが検出されません。IPv6 ネットワーク上でライセンス サーバを

使用すると、ライセンス サーバが正しく機能しません。  
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この問題を解決するには、http://www.autodesk.com/nlm2011-ipv6-windows から

最新バージョンの Autodesk Network License Manager をダウンロードしてくだ

さい。最新バージョンの Autodesk Network License Manager は IPv6 ネット  
ワークをサポートしています(Microsoft Windows Server 2008、Windows Vista 
32 ビット版、Windows Vista 64 ビット版のみ)。  

パッチをインストールするには: 
1. ライセンス サーバをシャット ダウンします。  
2. ライセンス マネージャ ファイルの内容をバックアップします。デフォルト

では、これらのファイルは C:\Program Files\Autodesk Network License 
Manager に格納されています。  

3. http://www.autodesk.com/nlm2011-ipv6-windows からパッチをダウンロード

します。 
4. パッチを解凍し、コピー & ペーストで古いファイル(デフォルトでは 

\Program Files\Autodesk Network License Manager にあります)を上書きし

ます(4 つのファイルが上書きされます)。  
5. ライセンス サーバを再起動します。  

Autodesk Network License Manager の IPv6 のサポート  
ここでは、最新バージョンの Autodesk Network License Manager に関する問題

を紹介します。  

バージョン 2011 のオートデスク製品に付属している Autodesk Network License 
Manager は、借用ライセンスの早期返却をサポートしていません。  

バージョン 2011 のオートデスク製品に付属している Autodesk Network License 
Manager は、IPv4 と IPv6 の混在環境のみをサポートしています。IPv6 のみの環境でネット

ワーク ライセンスをチェックアウトすることはできま せん。  

OpenGL  
MotionBuilder のシーンには、OpenGL® の制限により、ライトを最大 8 個までし

か追加できません。  
この問題は、Selective Lighting シェーダを使用してシーンにライトを追加するこ

とで対処できます。たとえば、Selective Lighting シェーダを使用してライトとオ

ブジェクトを関連付けると、シーン内のライトの数をオブジェクトごとに 8 個ま

で増やすことができます。  
Dynamic Lighting シェーダが適用されているオブジェクトと同じオブジェクトに、

Selective Lighting シェーダを追加しないでください。OpenGL の制限に対処する

には、代わりに Dynamic Lighting シェーダの Affecting Lights フィールドを使用

できます。  

Dynamic Lighting シェーダ  
デフォルト シェーダが適用されているモデルに、Append を選択して Dynamic 
Lighting シェーダを適用すると、フリッカー(ちらつき)などの問題が生じること

http://www.autodesk.com/nlm2011-ipv6-windows�
http://www.autodesk.com/nlm2011-ipv6-windows�
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があります。その場合は、Dynamic Lighting シェーダを適用する際に Replace 
By Type または Replace All を選択してデフォルト シェーダをデタッチしてくだ

さい。  

FCurve の補間  
MotionBuilder にマージ バックする際に、Smart Plot オプションがどのように設

定されていたかにかかわらず、一部の補間が失われてしまうという問題があり 
ます。  
注: この問題は、BaseAnimation レイヤ以外のレイヤにマージする場合には起こ

りません。  

レイヤ構造のテクスチャを Additive に設定した場合  
レイヤ構造のテクスチャを Additive に設定すると、合成およびクランプは 0 ～ 1 
の間で行われます。 

コントロール リグと HIK のカスタマイズ  
コントロール リグ プロパティの Solid Look では、エクストラ FK モデルが表示

されません。  
HIK リグの表示をカスタマイズする場合は、Properties Look メニューの

「Default」設定を使用してください。  

シーンへのテイクの追加  
FBTake を使用してシーンにテイクを追加すると、追加したテイクが Transport 
Controls に表示されません。  
この問題は、FBTake::CopyTake を使用することで対処できます。詳細は、

Python または C++ リファレンスの「FBTake Class Reference」を参照してくだ

さい。  

NVIDIA PhysX のソフト ボディ  
64 ビット版 OS では、PhysX のソフト ボディ機能はサポートされていません。  

物理ソルバ  
物理ソルバでは、縮退ポリゴン(ダミーポリゴン)や不正な法線は正しく処理され

ません。次のような問題が発生します。  
• Elements > Primitives フォルダの Sphere エレメントには、物理ソルバの処

理で予期しない結果が生成される可能性のあるジオメトリが含まれています。

この問題を回避するために、球体のモデルで物理ソルバ(リジッド ボディ、

ジョイント、ラグドールなど)を使用する必要がある場合は、Asset Browser 
の Primitives フォルダの polySphere エレメントを使用してください。  
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• 64 ビット システムでは、物理ソルバは縮退ポリゴン(ダミーポリゴン)や不

正な法線を含むオブジェクトを処理できません。その場合は、モデルに問題

のあるジオメトリが含まれていることを知らせる警告メッセージが表示され、

該当するシェイプはおおよその形状(近似)のバウンディング ボックスで表示

されます。このバウンディング ボックスが表示された場合は、ソルバの処

理で予測外の結果が生成されることがあります。可能な場合は、ジオメトリ

により近い、Cube、Capsule、または Sphere の近似を使用してください。

複雑なジオメトリの場合は、縮退ポリゴンや不正なポリゴンを含むモデルを 
3D ソフトで作成し直すことで、こうした非標準のジオメトリに起因する問

題を回避してください。  

ドキュメントの更新  
このセクションでは、MotionBuilder 2011 のリリース後に追加された、ドキュメント

と学習マテリアルに対する更新情報について説明します。最新版のドキュメントは、

http://www.autodesk.co.jp/motionbuilder-documentation  からダウンロードできます。  

MotionBuilder ヘルプ  
MotionBuilder 2011 のリリース以降に加えられたマイナーな変更を反映して、 
「Autodesk MotionBuilder 2011 ヘルプ」が改訂されています。  
注 : .zip ファイルの内容を、デフォルトの Autodesk MotionBuilder 2011 64-
bit\Help ディレクトリまたは Autodesk MotionBuilder 2011 32-bit\Help ディレクト

リに解凍してください。  

MotionBuilder 新機能  
MotionBuilder 2011 のリリースで Templates ディレクトリの変更に関する未解決

の問題が見つかったことに伴い、「Autodesk MotionBuilder 2011 新機能」ドキュ

メントが改訂されています。  

MotionBuilder ユーザ ガイド  
MotionBuilder 2011 のリリース以降にマイナーな変更が加えられました。また、

グラフィックスの問題が修正され、ファイル サイズも最適化されました。これら

を反映して、「Autodesk MotionBuilder 2011 ユーザ ガイド」が改訂されています。  

MotionBuilder チュートリアル  
MotionBuilder 2011 のリリース以降にグラフィックスに関するマイナーな変更が

加えられました。また、グラフィックスの問題が修正され、ファイル サイズも最

適化されました。これらを反映して、「Autodesk MotionBuilder 2011 チュートリ

アル」が改訂されています。  

  

http://www.autodesk.co.jp/motionbuilder-documentation�
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MotionBuilder インストールとライセンス発行ガイド  
MotionBuilder 2011 のリリース以降に記述にマイナーな変更が加えられました。

また、ライセンスの借用に関しても変更が加えられました。これらを反映して、

「Autodesk MotionBuilder 2011 インストールとライセンス発行」ガイドが改訂さ

れています。 
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Autodesk® Mudbox 2011 
 

 

リリースノート 

このリリースノートには、Autodesk® Mudbox® 2011 ソフトウェアのインス

トール、使用方法に関した最新情報のリンク先が含まれています。ソフト 
ウェアをインストールする前に本文書をお読みになることを推奨します。 

 

新機能に関する情報は、Mudbox ヘルプの "What's New" の項目を参照して

ください。 

                                         

http://www.autodesk.com/mudbox-docs-v2011-whatsnew 

Mudbox 2011 リリースノートは、Mudbox ヘルプの "Release Notes"の項目

を参照してください。 

Mudboxの学習リソース : 

http://www.autodesk.com/mudbox-v2011-releasenotes 

www.autodesk.com/mudbox-learningpath  

Mudbox 使用法に関した学習ビデオ : 

サポートリソース : 

www.autodesk.com/mudbox-trainingvideos 

Mudbox 2011 を使用するための公認ハードウェア、グラフィック カードに

関した最新リスト Mudbox 2011 Certified Hardware チャート : 

http://www.autodesk.com/mudbox-support 

Mudbox 2011 を使用するために最低必要とされるシステム : 

www.autodesk.com/mudbox-hardware 

 http://www.autodesk.com/mudbox-system-requirements 

 

http://www.autodesk.com/mudbox-docs-v2011-whatsnew�
http://www.autodesk.com/mudbox-v2011-releasenotes�
http://www.autodesk.com/mudbox-learningpath�
http://www.autodesk.com/mudbox-trainingvideos�
http://www.autodesk.com/mudbox-support�
http://www.autodesk.com/mudbox-hardware�
http://www.autodesk.com/mudbox-system-requirements�
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Mudbox SDK に関するドキュメント、サンプルは Mudbox インストール先

の \Mudbox2011\SDK をご覧ください。オンラインによる情報 : 

 

http://www.autodesk.com/mudbox-docs-v2011-sdkguide 

品質向上プログラム (CIP)  
Mudbox をはじめて起動すると、[オートデスク品質向上プログラム]ダイア

ログ ボックスが開きます。[オートデスク品質向上プログラム]への参加を選

択すると、Mudbox は、システム構成、最も多く使用する機能、遭遇した問

題、製品の今後の方向性に役立つその他の情報を自動的にオートデスクに送

信します。詳細は、www.autodesk.com/cipを参照してください。 

カスタマー エラー レポート (CERs) 
エンド ユーザの皆様からご送信いただく CER によって、オートデスクは 
Mudbox の安定性を大幅に向上させることができます。CER への入力に貴

重な時間を割いていただいたことに、感謝いたします。また、エラー発生時

にどのようなアクションを実行中であったか、できる限り詳しい情報を入力

していただくようお願い申し上げます。いただいた詳細な情報によって、

Autodesk Mudbox Engineering チームはプログラムの向上を円滑に進めるこ

とができます。  

CER の詳細については、 www.autodesk.com/cer をご覧ください。

http://www.autodesk.com/mudbox-docs-v2011-sdkguide�
http://www.autodesk.com/cip�
http://www.autodesk.com/cer�
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